
1  

User Manual  

Dockit Archiver 

  

Last Updated: March 2018  

Copyright © 2018 Vyapin Software Systems Private Ltd. All rights reserved.  

This document is being furnished by Vyapin Software Systems Private Ltd for information purposes only to licensed users of the Dockit 
Archiver software product and is furnished on an “AS IS” basis, that is, without any warranties, whatsoever, express or implied. Dockit  
Archiver is a trademark of Vyapin Software Systems Private Ltd. Information in this document is subject to change without notice and 
does not represent any commitment on the part of Vyapin Software Systems Private Ltd. The software described in this document is 
furnished under a license agreement. The software may be used only in accordance with the terms of that license agreement. It is 
against the law to copy or use the software except as specifically allowed in that license. No part of this document may be reproduced 
or retransmitted in any form or by any means, whether electronically or mechanically, including, but not limited to the way of: 
photocopying, recording, or information recording and retrieval systems, without the express written permission of Vyapin Software 
Systems Private Ltd.   

  

Vyapin Software Systems Private Limited  

Website: http://www.vyapin.com/    
Sales Contact: sales@vyapin.com   
Technical Support: support@vyapin.com  

 

http://www.vyapin.com/
http://www.vyapin.com/
mailto:support@vyapin.com


2  

Contents 
 

GENERAL INFORMATION .................................................................................................................. 3 
How to purchase? ...................................................................................................................................................... 4 

Application Data Folder Location ............................................................................................................................... 5 

Technical Support ...................................................................................................................................................... 7 

How to Register the Software? .................................................................................................................................. 9 

How to uninstall Dockit Archiver? ........................................................................................................................... 10 

DOCKIT ARCHIVER JOB MANAGER .................................................................................................. 13 
Job Manager ............................................................................................................................................................ 14 

Edit an existing job ................................................................................................................................................... 15 

Delete an existing job .............................................................................................................................................. 16 

Job History ............................................................................................................................................................... 17 

Run a Job .................................................................................................................................................................. 20 

Activity Log ............................................................................................................................................................... 23 

CREATE NEW ARCHIVE JOB ............................................................................................................ 26 
Create new archive job ............................................................................................................................................ 27 

Batch File.................................................................................................................................................................. 31 

Archive Items ........................................................................................................................................................... 34 

Archive Condition .................................................................................................................................................... 36 

Post Archive Actions ................................................................................................................................................ 38 

Threshold Settings ................................................................................................................................................... 39 

Schedule Settings ..................................................................................................................................................... 40 

CREATE NEW EXPORT JOB .............................................................................................................. 41 
Create new export job ............................................................................................................................................. 42 

Batch File.................................................................................................................................................................. 46 

Export Items ............................................................................................................................................................. 49 

Version Option ......................................................................................................................................................... 50 

List View Options ..................................................................................................................................................... 54 

List Column Options ................................................................................................................................................. 55 

Export Conditions .................................................................................................................................................... 57 

2.1 Site Level Conditions ................................................................................................................................ 58 

2.2 List Level Conditions ................................................................................................................................. 60 



3  

2.3 Folder Level Conditions ............................................................................................................................ 62 

2.4 File or Item Level Conditions .................................................................................................................... 65 

File Settings .............................................................................................................................................................. 68 

Permission Options .................................................................................................................................................. 71 

Metadata File Settings ............................................................................................................................................. 73 

Threshold Settings ................................................................................................................................................... 77 

Schedule Settings ..................................................................................................................................................... 78 

REFERENCE .................................................................................................................................... 79 
Troubleshooting ....................................................................................................................................................... 80 

 

General Information  
 

How to purchase? 

Technical support 

How to Register the software? 

How to uninstall Dockit Archiver  
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How to purchase?  

 

You can purchase Dockit Archiver online from our website http://www.vyapin.com/. Please 

contact our Sales department at sales@vyapin.com for sales and price related queries. 
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Application Data Folder Location 

 

Dockit enables you to change Application Data folder location, where Dockit’s export tasks and 
related settings, activity logs and error logs are stored, at any time after installing Dockit 
software. To change the Application Data folder location, perform the following steps given below: 

1) Select Product Activation option from Help menu 

 

2) The Product Activation page appears as shown below:                                                                

 

 

 

 

3) Click Change button to change Application Data folder location of Dockit 

application. The Browse for Folder location dialog will appear as shown below: 
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4) Select a desired folder location and Click OK. The folder location can be local drives 

or mapped network drives. 

 

5) Dockit provides an option to copy or move the existing Dockit application settings to 

the new location once you change the Application Data Folder. Once you specify the 

new Application Data folder location, Dockit will prompt you to copy or move existing 

Dockit application settings to the new location as shown below: 

   

 

 

6) Click the desired action (Copy / Move / Close) to proceed. Dockit will use the new 

Application Data folder location henceforth. 
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Technical Support 

 

Please send all Technical Support questions to support@vyapin.com.  

Please send us the following additional information if you are reporting a problem:  

1. Version of Dockit Archiver that you are evaluating or you have registered with us. 

(Version information could be found by clicking -> Product Activation) 

 

2. Additional services or resource consuming processes/applications (like anti-virus) 

running in the background on Dockit Archiver installed computer.  

 

3. Hardware configuration of the computer where Dockit Archiver is installed.  

 

4. Archiver_<date&timestamp>.txt" available in the common application data path of Dockit 
Archiver  
(e.g., <Application Data Folder>\Dockit Archiver\Log\Archiver    

<date&timestamp>.txt).  

 

5. Dockit Archiver jobs Timestamp folder stored in the application data path. For example: 

<Application Data Folder>\Dockit Archiver\Histories\<taskname>\<timestamp>. 
 

Note: 

<Application Data Folder> is the location where Dockit Archiver jobs and job history is stored in the 
computer running Dockit Archiver application. The <Application Data Folder> can be found by 

clicking -> Product Activation. The default path of <Application Data Folder> is as follows: 

Windows 10 / Windows 8 / Windows 7 / Windows Server 2012 / Windows Server 2008 - 
C:\Users\Public\Documents    

Select Report a problem option from Help menu as shown below. 
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How to Register the Software?  

 

Once you purchase the software online or through any one of our resellers, you will receive a 

purchase notification through e-mail from our sales department. We will send you an e-mail 

with the necessary instructions to register the software. 

Request License Key  

In case you do not receive an e-mail from our sales team after you purchase the software, please 
contact our sales department at sales@vyapin.com with the sales order number 
 

1. Select Product Activation from Help menu. 
 

2. The Product Activation page appears as shown below: 
 

 

3. Once you paste the license key, click Activate button to apply the new license key 

mailto:sales@vyapin.com
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How to uninstall Dockit Archiver? 

 

When you create SharePoint archive jobs in Dockit Archiver and schedule them, the application creates 
Windows Scheduled Tasks (to run the archive jobs at the specified time interval) in the computer where 
Dockit Archiver is installed. Archive job results for every task run instance is also maintained in the 
computer as application files.  

When you uninstall Dockit Archiver through Control Panel - Add / Remove Programs applet, Windows 
Installer program will remove only the application files from your machine. But, the application related 
files created by Dockit Archiver remain in the computer. In order to remove Dockit Archiver worker files 
completely, the uninstall wizard provides a set of cleanup options to perform the cleanup operation 
based your selection.  

Use this wizard to clean up the files that are created by Dockit Archiver application selectively and 

uninstall Dockit Archiver completely from the machine. 

 
1. The Dockit Archiver Uninstall Wizard dialog will be shown as below: 

 

 
 

       Click Next to proceed.  

 
2. Select required cleanup options as shown below:  
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      Click Next to proceed.  
 
3. Confirm the cleanup and/or uninstall process.  
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Click Finish to run cleanup and/or uninstall process. Click Cancel to close the wizard.  

 

4. Once the file cleanup process is complete, the uninstall wizard will automatically run 

Windows Installer program to remove Dockit Archiver application from the machine, if 

you have selected the cleanup option Uninstall Dockit Archiver application in the 

wizard. 
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Dockit Archiver Job Manager 
 

Job Manager 

Edit an Existing Job   

Delete an existing Job   

Job History  

Run a Job  

Activity Log   
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Job Manager    

 

1. The Job Manager page will appear as shown below. 
 

 

 

 

 

2. From this page, you can: 
 

 Create New Archive Job 

 Run a Job 

 Edit a Job 

 Delete a Job 

 View Job History 
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Edit an existing job   

 

To edit an existing job:  

1. Select a job from the Job Manager page. Click or click on icon and select Edit. 
 

2. Dockit Archiver loads SharePoint explorer and File explorer while retaining the configured job 
settings. 

   



16  

Delete an existing job 

 

To delete an existing archive job:  

1. In Job Manager Page, click icon of the job and select Delete. 

 

  

 

Note: Deleting a job will permanently delete the selected job and its history items.  
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Job History 

 

When a job is run in Dockit Archiver, the job information is updated in 'Job History' folder. The job 
history information can be viewed upon clicking 

 

Or Click on and select Show History. 

The history of the job will be displayed as shown below. 
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Where 

Start Time -> Date and Time a job was initiated. 

End Time -> Date and Time a job completed its archive process 

Elapsed Time -> Total time (hh:mm:ss) a job has taken to complete its archive process. 

Status -> Brief remark about the status of archive. 

Total -> Total number of files given for archive in this job. 

Total Size -> Total size of files under archive job. 

Action -> Deletes the logs and history details of that instance. 

Possible Status Description 

Completed Archive process was completed successfully without any errors 

Incomplete Archive process encountered certain errors 
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Eval limit reached Archive process reached the maximum allowed number of files 

to import in evaluation / trial version. This message is 

applicable for evaluation / trial version only. 

Cancelled Archive process was cancelled by the user. 

Failed The archive process could not be initiated as there were issues. 

 

The following operations can be performed on job history items: 

View activity log 
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Run a Job 

 

'Start' option of a job in job manager page allows the user to instantiate a job any time after the job 
has been created. To run a Dockit Archiver job:  

1. In Job Manager Page, Click Start option of the job or click on icon and select Run Job 

 

 

 

2. Office 365 Login Dialog to connect to SharePoint will appear as shown below. 
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The given credential will be used to connect to the SharePoint site. 

3. The progress of the job will be reported as shown below: 
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4. It shows the files that are being archived to File share. 

Where 

Name -> Title of the file. 

Source Path -> SharePoint Location of the file. 

Size -> Size of the file. 

Target Path ->File Share location of the file. 

State -> Current State of the file (i.e. In Queue (or) Uploading (or) Completed) 

     Status: 

a. Files Archived - Shows the total number of files archived to File Share.  

b. Size - Size of files Archived - Total size of files provided for archive.  
c. % - Shows the progress of the job in Percentage (%).  
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d. Elapsed Time - Shows the elapsed time from the instance the archive job started or 
commenced. 

5. Once the archive job is complete, the information will be updated in Job History section, where 
you can view the archive activity performed when the job ran last. 

 

Activity Log 

 

To view activity log associated with a job history item: 

1. Click on Status column value.  
 

 
2. The Activity Log Viewer page appears as shown below. 
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3. The activity log of a job is classified into two different categories :  

  
 a. Statistics: Displays a brief summary of the archive process.   
 b. Status: Displays the task details of the archive process. 

 
Summary View - Displays the summary report of the archive process. 
 
Where 
Title -> SharePoint List/Web Name 
Source -> SharePoint location of a file 
Target -> File system location of a file. 

Activity Date -> Start time of the archive job. 
Status -> State of a List/Web (Archived or Failed). 
Remarks -> Brief information about why the List/Web failed to archive. 

 
 
Detailed View - Displays the detailed report of the archive process. 

 
Where 
Source -> SharePoint location of a file 
Target -> File system location of a file. 
Size ->Size of the file that is archived. 
Activity Date -> Start time of the archive job. 
Status -> State of a file (Archived or Failed). 

Remarks -> Brief information about why the file failed to archive. 
Version History -> Display the File Versions, if available.  
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4. Additionally, user can open the file share location of activity log by clicking Open log folder 

control on top. 
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Create new archive job 
 

 

Create New Archive Job  

Batch File 

Archive Items 

Archive Condition  

Post Archive Actions 

Threshold Settings 

Schedule Settings 

 

 

  



27  

Create new archive job  

 

To create a new archive job to archive SharePoint Lists and Subsites along with metadata from 
SharePoint to File System: 

1. Click Create New Archive Job on Job Manager Page as shown below. 

 

2. Select archive type from Select Type popup as shown below. 
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3. The New Archive page appears as shown below 
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4. Enter Job Name, Description (Optional). 
5. Specify Office 365 or On-premises site URL in the textbox and click Connect button. You need to 

provide a valid site administrator credentials to proceed further. 
6. Drag and Drop SharePoint Lists from SharePoint site (Left Pane) to File share (Right Pane) or 

Select SharePoint Objects and Right click SharePoint Explorer, select Archive. 
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7. Click Archive Items on right pane to check the list of SharePoint Objects selected for archive, also 

you can remove SharePoint Objects by clicking the Red X. 

8. Click Batch File in the right pane to archive lists, sites and metadata to target file system. 

9. Specify Archive Condition 
10. Specify Post Archive Actions 

11. Specify Threshold Settings 
12. Specify Schedule Settings 
13. Click Save button to create the job, or click < button to navigate to previous page to change any 

job settings. 

14. After saving the job, it will be listed on the Job Manager page. You can click on to 
initiate the archive process. 
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Batch File 

 

The following section gives you the guidelines to create a batch file for archive lists, sites and metadata 

to target file system path. 

The first row of the batch file should contain the following field names as headers. The reserved headers 

used by Dockit Archiver in batch file are as follows: 

1. Path: The 'Path' column should contain the path of the source list / site. 

2. Destination Path: The 'Destination Path' column should contain the target location where the 

source gets moved. 

 

Follow the steps given below to specify the lists/sites to archive in the target File System Location in 

the batch file 

1. Drag-n-drop batch file in Batch tab from explorer. It will be shown below 

 

 

Batch file content will be shown as below. 

Path Destination Path 

http://sharepoint/technical documents/folder1 M:\My Document 
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2. Click Validate button to verify the batch content 
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Once the validation is complete, click Continue button to proceed for next step and the batch file 
content will be added to Archive Items tab 
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Archive Items  

 

From SharePoint explorer you can either drag or drop SharePoint Objects to File explorer or simply 

select SharePoint Objects from SharePoint explorer Right Click and Select Archive to add SharePoint 
Objects to Archive Items.   

1. The Archive Items appears as shown below: 

  

 

 

2. The selected SharePoint Objects added for archive will be displayed in the Archive Items page. 

Dockit Archiver processes the top-level SharePoint Objects added for archive in the order in which 
it appears in the Archive Items page. The archive process order can be changed by the navigation 
buttons available in the right side of the page. You can remove the SharePoint Objects added for 
archive by clicking top right of the listed entries. The delete image appears as shown below: 
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3. Click > button to proceed. 
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Archive Condition 

 

To specify the Archive Condition to be applied by Dockit Archiver when archiving SharePoint Objects to 
the destination location:  

1. The Archive Conditions appears as shown below: 
 

 

 

 
 

 
2. Select any one of the following Archive Conditions as stated below:  

 

a. Archive Everything - Archives all SharePoint Objects without applying any condition or rule 
to filter content.  
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b. Items inactive since / older than - Archives SharePoint items that were last modified 

earlier than the given date.  
c. Items modified between - Archives SharePoint items modified between from and to date. 

The To date is an optional value. The items that were modified in the given date range alone 

will be archived along with its respective item versions.  
d. Items created/modified by user - Archives SharePoint items that were either created or 

modified (depending on the user selection) by the given user or set of users.  
e. Keep the following number of major versions - Retains the specified number of major 

versions in SharePoint and archives document versions anything above the defined count.  
f. Files more than this size - Archives SharePoint documents that are greater in size than the 

given value.  

g. Lists having more than these many documents - Archives SharePoint Lists that have 
documents / files anything above the defined count.  

h. Lists inactive since / older than - Archives SharePoint Lists that were last modified beyond 
the specified date.  

i. Lists modified between - Archives SharePoint Lists that were modified between from and to 
date. The To date is an optional value. 

 

 

 

3. Click  to proceed. 
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Post Archive Actions 

 

This page allows you to specify the Post Archive Actions to be applied by Dockit Archiver when archiving 
SharePoint Objects to the destination location.  

 1. The Post Archive Actions page will appear as shown below: 

 

 

2. Select any one of the following post archive actions given below: 

a. No action to be taken - No action will be taken, once the archive job is complete.  
b. Delete all items in source after archive job is complete - Deletes the SharePoint objects 

that are archived. This option will delete all items in the source list permanently and you won’t 
be able to retrieve these items from the Recycle Bin.  

c. Make all items in source as read-only after archive job is complete - The SharePoint 

objects that are added for archive will be marked as Read-only objects by altering their 
permissions. Any sub-scopes that are created underneath SharePoint sites or lists will be 
automatically set to inherit parent permissions. For example, any unique permissions defined 
for documents and folders underneath source SharePoint list will be changed to inherited 
permissions.  
 
Note: This option will be enabled only when Archive everything option is selected in the Archive 
Condition settings. 
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 3. Click  to proceed. 

Threshold Settings  

 

To set percentage of Network bandwidth that Dockit Archiver can use during archiving and number of 
files that can be archived concurrently to improve performance. 
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Schedule Settings  

 

1. The Job Schedule Settings step appears as shown below: 
 

 

 

 

 

2. Select a Schedule type from Schedule drop-down menu. 
3. Click Set Password to specify Username and Password to run the task. 
4. Click Save, a windows scheduled task will be created. 
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Create new export job 
 

 

Create New Export Job  

Batch File 

Export Items  

 Version Options 

 List View Options 

 List Column Options 

 Export Conditions 

File Settings  

Permission Options   

Metadata File Settings 

Threshold Settings 

Schedule Settings 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



42  

 

 

 

Create new export job  

 

  

This page allows you to create a new export job to export SharePoint lists and Subsites along with 
metadata from SharePoint to File System. 

1. Click Create New Export Job as shown below. 
 

 

 

 

 

2. Select export type from Select Type popup as shown below. 
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3. The New Export page will appear as shown below 
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4. Enter Job Name and Job Description (Optional). 

5. Specify Office 365 or on premise site URL in the textbox and click Connect button. You need 

to provide a valid site administrator credentials to proceed further 

6. Drag and Drop SharePoint lists from SharePoint site (left pane) to File share (right pane) or 
select SharePoint Objects, right click SharePoint Explorer and select Export . 
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7. Click Batch File in the right pane to export lists, sites and metadata to target file system. 

8. Click Export Items in the right pane to verify the list of SharePoint Objects selected for export. 

9. Specify File Settings 

10. Specify Permission Options  

11. Specify Metadata File Settings 

12. Specify Threshold Settings  

13. Specify Schedule Settings 

14. Click Save button to create the job, or click < button to navigate to previous page to change 

any job settings. 

15. After saving the job, it will be listed on the Job Manager page. You can click on to 
initiate the export process. 
 

 
 

 

 
 

 



46  

Batch File 

 

The following section gives you the guidelines to create a batch file for export lists, sites and metadata 
to target file system path. 

The first row of the batch file should contain the following field names as headers. The reserved headers 
used by Dockit Archiver in batch file are as follows: 

1. Path: The 'Path' column should contain the path of the source list / site. 

2. Destination Path: The 'Destination Path' column should contain the target location where the 
source gets moved. 

 

Follow the steps given below to specify the lists/sites to export in the target File System location in the 

batch file 

1. Drag-n-drop batch file in Batch tab from explorer. It will be shown below 

 

 

Path Destination Path 

http://sharepoint/technical documents/folder1 M:\My Document 
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Batch file content will be shown as below. 

 

 

 

2. Click Validate button to verify the batch content 
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Once the validation is complete, click Continue button to proceed for next step and the batch file 

content will be added to Export Items tab 
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Export Items 

 

1. In SharePoint explorer, you can either drag and drop SharePoint Objects to File explorer or simply 

select SharePoint Objects from SharePoint explorer, right click and select Export to add SharePoint 

Objects or select SharePoint Objects from SharePoint explorer and click  to add them for Export. 

The Export Items appears as shown below: 

  

 

 

2. The selected SharePoint Objects added for export will be displayed in the Export Items page. 
Export Jobs processes the top-level SharePoint Objects added for export in the order in which they 
appear in the Export Items page. The export process order can be changed by using 
the navigation buttons available in the right side of the page. You can remove the SharePoint 

Objects added for export by clicking Top right of the listed entries. 

The Delete Items appears as shown below: 
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1. Version Options 

2. List View Options 

3. List Column Options 

4. Export Conditions 

Version Option 

 

1. To selectively export list item versions to the destination file system location:  

The Version Options step appears as shown below: 

 

 

 

Export Versions:  

By default, All versions option is selected. Item version settings will be used for each of the 

list items exported from the list. Select any one of the following version settings:  
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i. All versions - Export all list item versions available in the source list.  

ii. Export version range - Export only list item versions specified in the range from the 

source list e.g., versions 2 to 5.  

iii. Export date range - Export only list item versions by date specified in the range from 

the source list e.g., versions date 11/19/2010 - 15/19/2010. The source list date used 

for exporting is Modified date of a list item.  

iv. Export major versions only - Export the major list item version from the source.  

v. Latest version only - Export the latest list item version from the source. 

   2.  File Version Handling (Libraries only):  

           Select any one of the following export options: 

i. Export each version to a version folder named as - This option will create a version 

folder for each file version based on the version folder name specified in the folder name 

mask textbox. You have the option to export the latest file version to the root folder or 

export it to the respective version folder. 

Store latest version in root folder – Export the latest file version to the root folder 

specified by the user. To select Version folder name, click the button placed next to 

the export version to as version folder name textbox. Version folder name mask dialog 

appears as shown below: 
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Store latest version in the respective version folder - This option will create a 

version folder name based on the current file version and export the file into the 

version folder. 

 

ii. Export each file version as separate files named as - Each file version will be exported 

using the file version name constructed in the file version name mask text box. To select 

Version file name, click the button placed next to the export version to a separate file name 

textbox. Version folder name mask dialog appears as shown below: 

 

 

 

3. For Latest version Only option in the Export Versions, you have the option to export the latest 

file version to the root folder or export it to the respective version folder. The File Version 

Handling settings appears as shown below:  
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i. Store latest version in root folder - Export the latest version in the root folder itself 

ii. Store latest version in the respective version folder - Creates a latest version 
folder and    export the latest file version in the latest version folder 

 

4. Click  button to proceed. 
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List View Options 

 

 

You can export list items or documents based on SharePoint List views and thereby specify the SharePoint 
columns to export metadata. 

 
    To selectively export SharePoint Views from the list / library, follow the steps outlined below: 

 

1. The List View Options wizard step appears as shown below: 

 

The List View Options wizard step appears as shown below: 

 

  

 

 

 
2. Select any one of the following View Settings given below 



55  

 

All items in the SharePoint List - Export all items / documents (including folders) in the list view as 
it appears in Allitems.aspx web page corresponding to the list. 

 

Default List View - Exports all items (including folders) available in the Default view of the given 
SharePoint list. The SharePoint columns defined in the default view will be exported to the metadata 
file. 

 

All List Views - all Views in the SharePoint list. The SharePoint columns defined in the respective list 
views will be exported to the metadata file. 

 

Specific List Views - Exports views that are specified in the textbox. The SharePoint columns defined 
in the respective list views will be exported to the metadata file. 

 

Dynamic View - Exports subset of items from SharePoint list based on CAML filter query. You can 
specify the required metadata columns using "List Column Options". 

 
3. Click  to proceed 

 

List Column Options 

 

1. You can export list items or documents based on specify the SharePoint columns to export metadata. 

i. Export all columns - all columns available in the source SharePoint list, including built-in 

SharePoint columns such as Created, Modified, Approval Status, etc. 

ii. Export all user defined columns - Exports all columns that are created by a SharePoint user. 

iii. Export selected columns - Exports columns that are specified in the textbox. 
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Note:   

 ViewName is applicable only for View based export. Export Jobs will substitute the name of the 
processed view wherever applicable. 

Content export:  

For list / library entries, it creates a new folder with the view name under the list / library name folder 
in the specified destination location. 

For file / folder entries provided for export, it exports the content in the specified export location. 

Metadata export: 

For list / library entries and for files / folders within them, it exports metadata for columns present in 
the view. 

For file / folder entries provided for export, it exports metadata for all columns (including SharePoint 
maintained read-only columns), instead of the view based columns. 
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2. Click  to proceed 

Export Conditions 

 

Export Jobs can export folders, files and list items (including file attachments) from a SharePoint list 
or library based on certain export conditions. The conditions can be created by using SharePoint 
columns in the source list or library. 

1. The Export Conditions step appears as shown below: 

 

 

 

  
 

  

 

                You can specify export conditions at four levels: 

i. Site Level Filter 
ii. List Level Filter 
iii. Folder Level Filter 
iv. File or Item Level Filter 
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2.1 Site Level Conditions 
i. Click Site level filter... to specify the conditions. The Site Level Filter dialog appears as 

below: 

 

 

 

ii. You can specify the export conditions by selecting the field name and by specifying a value with 

necessary operator. You can use mathematical operators such =, <> to define your query. 

Complex queries can be constructed with the use of left-right parenthesis '(' and ')' and logical 

operators 'AND' and 'OR'. 
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iii. Export Jobs will export the sites that satisfy the export condition or export the sites that do not 

satisfy the export condition depending on the option selected by the user: 

 

a) Export sites if the above conditions are satisfied - Sites that satisfy the 

condition will be marked for export 

b) Export sites if the above conditions are not satisfied - Sites that do not satisfy 

the condition will be marked for export. 
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2.2 List Level Conditions 
i. Click List level filter... to specify the conditions. The List level filter dialog appears as below: 

 

 

 

ii. You can specify the export conditions by selecting the field name and by specifying a value with 

necessary operator. You can use mathematical operators such =, <> to define your query. 

Complex queries can be constructed with the use of left-right parenthesis '(' and ')' and logical 

operators 'AND' and 'OR'. 
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iii. Export Jobs will export the lists that satisfy the export condition or export the lists that do not 

satisfy the export condition depending on the option selected by the user: 

 

a) Export lists if the above conditions are satisfied - Lists that satisfy the condition 

will be marked for export. 

b) Export lists if the above conditions are not satisfied - Lists that do not satisfy the 

condition will be marked for export. 
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2.3 Folder Level Conditions 
i. Click Folder level filter... to specify the conditions. The Folder level filter dialog appears as 

below: 

 

 

 

ii. Click  button to add the SharePoint columns in Field Name dropdown. The Add Fields 

dialog appears as shown below: 
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Specify the column name in Name textbox and select the data type of the column in SharePoint 

from Type drop-down. 

Click Add button to add the columns to the fieldname dropdown list. 

Click Remove button to remove the columns from the fieldname dropdown list. 

 

iii. You can specify the export conditions by selecting the field name and by specifying a value with 

necessary operator. You can use mathematical operators such =, <> to define your query. 

Complex queries can be constructed with the use of left-right parenthesis '(' and ')' and logical 

operators 'AND' and 'OR'. 
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iv. Export Jobs will export the folders that satisfy the export condition or export the folders that do 

not satisfy the export condition depending on the option selected by the user: 

 

a) Export folder if the above conditions are satisfied - Folders that satisfy the 

condition will be marked for export. 

b) Export folder if the above conditions are not satisfied - Folders that do not satisfy 

the condition will be marked for export. 
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2.4 File or Item Level Conditions 
i. Click File or Item level filter... to specify the conditions. The File or Item level filter dialog 

appears as below: 

 

 

 

ii. Click  button to add the SharePoint columns in Field Name dropdown. The Add Fields 

dialog appears as shown below: 
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Specify the column name in Name textbox and select the data type of the column in SharePoint 
from Type drop-down. 

Click Add button to add the columns to the fieldname dropdown list. 

Click Remove button to remove the columns from the fieldname dropdown list. 

 

iii. You can specify the export conditions by selecting the field name and by specifying a value with 

necessary operator. You can use mathematical operators such =, <> to define your query. 

Complex queries can be constructed with the use of left-right parenthesis '(' and ')' and logical 

operators 'AND' and 'OR'. 
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iv.  

Export Jobs will export the folders that satisfy the export condition or export the folders that do 

not satisfy the export condition depending on the option selected by the user: 

 

a) Export list items if the above conditions are satisfied - Files or list items that satisfy 

the condition will be marked for export. 

b) Export list items if the above conditions are not satisfied - Files or list items that do 

not satisfy the condition will be marked for export. 

 

2. Click  to proceed 
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File Settings 

 

To construct Alternate File Mask and to propagate Created Date and Modified Date from SharePoint 

Library to Windows File System, use below options: 

1. Alternate File Name Mask: 

If the file with the same name already exist in the destination location, follow the steps 

outlined below: 

 

 

 

 

  
 

  

 

i. Do not overwrite the existing file - Skips the file without overwriting the existing 

file with the same name. 

ii. Overwrite the existing file - Deletes the file from the destination location and 

exports the current source file. 

iii. Rename the new file that is currently exported from SharePoint - Rename 

the file based on the file name mask specified in the Alternate File Name Mask text 

box. 
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To select alternate file naming mask, click the alternate file name mask button placed next 

to the alternate file name mask textbox. Alternate file name mask dialog appears as shown 

below: 

 

 

Construct alternate file naming mask with the available macros provided in the dialog. Click 

OK to close the dialog. The new files will be exported in the name format / syntax entered 

in the file naming mask. 

 

2. File System Date Settings: 

To propagate the system date fields - Created Date and Last Modified Date to respective 

folders and files in the file system, follow the steps outlined below: 
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Select File System Date Settings: 

The date options given below will assign the respective data field values in the file system 

as in the original SharePoint list. 

 

i. Retain created date - Carry forward / propagate Created Date field from the 

source folders, files and list item attachments to the Windows file system. 

ii. Retain modified date - forward / propagate Last Modified Date field from the 

source folders, files and list item attachments to the Windows file system. 

 
Note: You can propagate original Created Date and Last Modified Date for folders and files to the 
NTFS file system. In a FAT file system, the Last Modified Date alone will be retained as in source. 

 

3. Click  to proceed. 
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Permission Options 

 

Export Jobs can export SharePoint site / list / list item permission information to the metadata file. 

1. The Permission Options specification wizard step appears as shown below: 

 

 

 

  
 

  

 

 
Export Permissions: 

i. Do not export permissions - This option will not export permissions to the 

metadata file. 
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ii. Export permissions - This option will export permissions based on the user 

specified options. The export permission options appear as shown below: 

 

 
 

 

 

2. You can export permissions for Site / List / List item to the metadata file depending on 

the user selection. Check appropriate checkboxes in Export permission for: options. 

Note: You can export list item permission from SharePoint 2013 or later. 

3. Specify the Permission format to use when exporting the permission information for the 

Site / List / List item to the metadata file using the options given below: 

 

i. User - Role format – Exports permission details as User – Role e.g., johndoe: 

Full Control, Limited Access; johnsmith: Read, View Only etc. 

ii. Role - User format – permission details as Role – User e.g., Full Control: johndoe, 

johnsmith; Contributor: janedoe etc. 
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4. Inheritance status - Export the inheritance status of the Site / List / List item as a separate 

column / field in the metadata file. This column / field indicate if the permission is 'Inherited 

or Unique' role assignment at the Site / List / List item level in SharePoint. 

5. Membership information - This option exports AD information and role definition 

information to separate XML files. These XML files are stored in the same location as the 

metadata files in the name _membership information and _role definition. The user account 

that connects to SharePoint must have (System Account) permission to retrieve respective 

membership information. Similarly, the user account specified in Active Directory Profile 

Manager for each domain must have (Domain Admin) permission to retrieve respective 

membership information. Export Jobs will enumerate only the globally declared domain 

groups and retrieve membership information. 

6. Click  to proceed 

 

Metadata File Settings 

 

 

Export Jobs will create metadata files based on the following options given below. 

1. The Metadata File Settings step appears as shown below: 

. 
The Metadata File Settings step appears as shown below: 
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2. Specify the Metadata file location using the options below: 

 

i. Store metadata file(s) in this location: Specify a folder path where the selected list 

items metadata are to be exported. You can also Click browse button to launch folder 

browser dialog. 

ii. Store metadata file(s) in the respective list / library folder location in the file 

system: - This option will export the metadata file in the selected file format into the 

respective list folder locations where the physical documents/ files are exported. 

Note: Ensure that the user context used to run the Export Jobs export process has sufficient 

permissions to create, edit and delete folders and files in the specified export path. 

 

3. If the metadata file already exists in the destination location, choose from any one of the 

following options: 

 

i. Overwrite: This option will overwrite the existing metadata file. 
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ii. Append: This option will append the new metadata to the existing metadata file. The 

new metadata will be shown in the new sheet with the name of current timestamp in 

XLSX file. 

 

4. You can specify a new metadata custom format based on the column name when generating 

the metadata file. The format specified here overrides the application level template defined in 

Metadata Format Template tool. Also, you can specify new column names to use when 

generating the metadata file in the file system location. To use this feature, click the Edit 

button. A Customize Metadata Format Dialog appears as shown below: 

 

 

 

5. Specify SharePoint column name in the Column Name textbox and select its type from the 

available Column Type from combo box. Click  button to load the available fields. Select 

format from the available fields. If you want to rename the SharePoint column name when 

exporting to the metadata file, provide a new name in the New Column Name text box. For 

example, a SharePoint column named 'Area' in the source SharePoint list can be customized 

and renamed as 'Location' when creating the metadata file during the export operation. 
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Click  to add the SharePoint column name and its format in the custom metadata format 

list. 

Click  to remove the SharePoint column name from the custom metadata format list. 

6. Click  to proceed 
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Threshold Settings 

 

 

Set percentage of Network bandwidth that Dockit Archiver can use during export and number of files 

that can be exported concurrently to improve performance. 
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Schedule Settings 

 

 

1. The Job Schedule Settings step appears as shown below:  

 

 
 

 

 

2. Select a Schedule type from Schedule drop-down menu. 

3. Click Set Password to specify Username and Password to run the task. 

4. Click Save, a window scheduled task will be created. 
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Reference   

 

  

Troubleshooting 
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Troubleshooting  

 

If and when a problem arises, please forward the following files to support@vyapin.com to revert back 
to you with a solution. 

1. Error log file - e.g., <Application Data Folder> \Dockit Archiver\Log\Dockit_<date&time-

stamp>.txt  

2. For issues while running a job, send us the date and time-stamp folder generated within 

the job folder name under 'JobHistory' folder. e.g., <Application Data Folder> \Dockit 

Archiver\Histories\<JobName>\<Date&Timestamp>.The date and time-stamp folder 
contains:  

 Activity log file (ActivityLog.csv)  

 Error log file (Archiver_20160409-134848.txt)  

 Job settings file (Detail.xml)  

 Items to Archive (Items to Archive.csv)  

 Job Execution file (JobExecution.xml)  

 Migration Statistics file (ArchiveStatistics.xml)  

 Upload Statistics file (UploadStatistics.xml) 

3. The <Application Data Folder> is the common location where Dockit Archiver jobs and job 
history will be stored in the computer running Dockit Archiver application. The <Application Data 

Folder> can be found by clicking  -> Product Activation. The default path of <Application 

Data Folder> is as follows: 
Windows 10, Windows 8, Windows 7, Windows Server 2008, Windows Server 2012 - 
C:\Users\Public\Documents. 

mailto:support@vyapin.com

